
Planning and Creating a
Custom Database

Introduction

The Microsoft Office Access 2007 database wizards make cre-
ating databases easy, but you may need to create a database
that does not fit any of the predefined template choices. In
that situation, you may need to create the database “from
scratch.” 

Creating a database from scratch involves careful plan-
ning. You must:

◆ Determine the purpose and scope of your data
base.

◆  Decide what tables your database will contain and 
what the content of those tables will be.

◆  Define how data in one table is related to data in 
another table.

When you create a database from scratch, you can take
advantage of the tools that Access provides. If you don’t plan
to create a database from scratch but instead plan to use only
existing Access databases, you might not need the informa-
tion in this chapter. Understanding database design concepts,
however, will help you better understand how to create effec-
tive queries later on. 3

3
What You’ll Do

Create a Custom Database Template

Plan Tables

Create Tables in a Database

Create a Table by Entering Data

Create a Table Using a Template

Import Data into Tables

Link to Data in Tables

Working with Table Records

Work with a Table in Design View

Specify a Primary Key in Design View

Plan Table Relationships

Define Table Relationships

Create and Print a Table Relationship
Report

Ensure Referential Integrity

Identify Object Dependencies

Modify Object Dependencies
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When you create a blank database in the Getting Started with
Microsoft Office Access 2007 dialog box, Access uses a database file
called Blank.accdb for Access 2007 or Blank.mdb for earlier versions of
Access located in the templates folder. If you want to create a custom
blank template, you can save your own database file with the name
Blank in the templates folder. The new custom blank template can con-
tain any object type you want, such as forms, reports, macros, or addi-
tional tables. If you no longer want to use a custom blank database,
delete or rename the file named Blank, and Access creates a new
default blank database for you.

Creating a Custom
Database Template 

Create a Custom Blank Template
Database

Start Access, or click the Office
button and then click New. 

In the left pane, click Featuring. 

Click Blank Database. 

Click the Browse button.

Click the Save in list arrow, and
then select one of the following
locations: 

◆ System template folder.
C:\Program Files\Microsoft
Office\Templates\1033\Access.

A template in the System folder
overrides a template in the
User folder.

◆ User template folder.
C:\Users\user name\Documents
(Vista), or C:\Documents and
Settings\user name\App
Data\Microsoft\Templates (XP).

Click the Save as type list arrow,
and then click a file type. 

Type Blank.accdb (or Blank.mdb,
if you are creating an earlier-
version template) in the File name
box.

Click OK.

Click Create.9
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Create a Custom Template
Database from an Existing
Database

Start Access, click the Office
button and then click Open. 

Click the Files of type list arrow,
and then click a file type. 

If the file is located in another
folder, click the Look in list arrow,
and then navigate to the file. 

Click the database file you want to
use as a blank template.

Click Open.

Click the Office button, click Save
As, and then select the format you
want: Access 2007 Database,
Access 2002 - 2003 Database, or
Access 2000 Database.

Click the Save in list arrow, and
then select one of the following
locations: 

◆ System template folder.
C:\Program Files\Microsoft
Office\Templates\1033\Access.

◆ User template folder.
C:\Users\user name\Documents
(Vista), or C:\Documents and
Settings\user name\App
Data\Microsoft\Templates (XP).

Type Blank.accdb (or Blank.mdb,
if you are creating an earlier-
version template) in the File name
box.

Click Save.9
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Although you can always make changes to
your database when necessary, a little plan-
ning before you begin can save time later on.
When you plan a database, consider how you
will use the data. What kind of data are you
collecting? What kind of data are you enter-
ing? How are data values related to one
another? Can your data be organized into sep-
arate, smaller groups? What kinds of safe-
guards can you create to ensure that errors
do not creep into your data? As you consider
these questions, you should apply the
answers as you structure your database.

Plan Tables
Tables are one of the fundamental building
blocks of a database. Database planning
begins with deciding how many and what
kinds of tables your database will contain.
Consider organizing your database informa-
tion into several tables—each one containing
fields related to a specific topic—rather than
one large table containing fields for a large
variety of topics. For example, you could cre-
ate a Customers table that contains only cus-
tomer information and an Orders table that
contains only order information. By focusing
each table on a single task, you greatly sim-
plify the structure of those tables and make
them easier to modify later on.

Choose Data Types
When you create a table, you must decide
what fields to include and the appropriate for-
mat for those fields. Access allows you to
assign a data type to a field, a format that
defines the kind of data the field can accept.
Access provides a wide variety of data types,
ranging from text and number formats to
object-based formats for images, sound,

video clips, and embedded macros (New!).
Choosing the correct data type helps you
manage your data and reduces the possibility
of data-entry errors. To make it easier to cre-
ate fields, Access provides the Add New Field
column (New!) in Datasheet view so you can
quickly enter a field name. If you already have
a defined field in the database that you want
to use again, you can drag the existing field
from the Field List pane (New!) on to the
datasheet and Access automatically creates a
relationship or guides you through the
process. You can also use field templates
(New!) for creating new fields. A ffiieelldd  tteemm--
ppllaattee is a design for a field, complete with a
name, data type, length, and predefined prop-
erties. You can drag field templates onto the
datasheet. Field templates are XSD based so
that you can set up standard definitions for
shared use. If you create a field for numbers,
you can use the Totals row (New!) to calculate
values using functions such as sum, count,
average, maximum, minimum, standard devi-
ation, or variance.

Specify a Primary Key
You should also identify which field or fields
are the table's primary keys. Primary keys are
those fields whose values uniquely identify
each record in the table. A social security
number field in a personnel table could be
used as a primary key, since each employee
has a unique social security number. A table
with time-ordered data might have two pri-
mary keys—a date field and a time field
(hours and minutes), which together uniquely
identify an exact moment in time. Although
primary keys are not required, using them is
one way of removing the possibility of dupli-
cate records existing within your tables.

Planning Tables AC07S-1.3.1,
AC07S-1.3.2
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After creating a database file, you need to cre-
ate the tables that will store the data. There
are several ways to create a new table: in
Datasheet view, in Design view, with Table
Templates, SharePoint Lists, or by importing a
table or linking to the data in a table from
another Access database. Depending on the
method you choose, creating a table can
involve one or more of the following:

◆ Specifying the fields for the table

◆ Determining the data type for 
each field

◆ Determining the field size (for 
text and number fields only)

◆ Assigning the primary key

◆ Saving and naming the table

Creating Tables in a Database

Methods for Creating a Table

Type Method Description

Datasheet Table button on When you create a table in Datasheet view, you can start 
the Create tab viewing and entering data right away. Access automatically 

assigns a data type based on the kind of information you entered 
in the field, and it assigns a default field size for text and number 
fields. After you close and save the table, Access prompts you to 
identify a primary key or to allow Access to designate one for 
you.

Table Template Table Templates button When you create a table using table templates, you select the 
on the Create tab type of table you want. Access provides several table templates, 

including Contacts, Tasks, Issues, Events, and Assets. 

Design Design View button In Design view, you must specify the fields, specify the data type 
on the Create tab for each field, assign the size (for text and number fields), assign 

the primary key, and save the table yourself.

SharePoint SharePoint Lists button When you create a table using data from a SharePoint list, you 
on the Create tab select the type of table you want. Access provides several table 

types, including Contacts, Tasks, Issues, Events, Custom,and 
Existing SharePoint List. 

Importing Access button on the If you want to use data from another Access database in the 
External Data tab database you are creating, you can import it. When you import a 

table, all the field names and data types are retained with the 
imported data. However, you must name the new table and 
identify the primary key or have Access create a primary key for 
you. Also, you may need to change the field size and other 
properties after importing.

Linking Access button on the When you link a table, the data is retrieved from a table in 
External Data tab another database. Linking a table saves disk space because 

there is only one table rather than multiple tables with the same 
data. Linking a table saves time because there is no need to 
update the same information in more than one table.

AC07S-1.2.2
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Access allows you to display many of its objects in multiple viewing
modes. Datasheet view displays the data in your tables, queries, forms,
and reports. Design view displays options for designing your Access
objects. You can create a new table in both views. When you create a
table in Datasheet view, you enter data and Access creates the table
as you type. Access determines the data type of each field based on
the data you enter (New!). When you finish entering data, Access will
prompt you for the name of the table you’ve just created. 

Creating a Table by
Entering Data

Enter Data to Create a Table

Click the Create tab.

Click the Table button.

Enter the data. 

Press Tab to move from field to
field or click in a cell.

To change a field name, double-
click the field name, type the new
name, and then press Enter. 

Click the Save button on the Quick
Access Toolbar. 

Type a table name. 

Click OK. 

To have Access set the primary
key, click Yes. 

Click the Close button in the Table
window. 
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Did You Know?
You can select or resize a column or
row like in Excel. To select a column
or row in a table, click the Column or
Row selector. To resize a column or
row, drag the border between the
Column or Row selector. You can also
click the Home tab, and then click the
More button to access commands to
resize columns and rows.
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A table template is a predefined table with fields you can quickly insert
and use in a database. Access provides several table templates
(New!) including: Contacts, Tasks, Issues, Events, and Assets. You can
use the Create tab to quickly insert a table template. After you insert a
table template, you can change fields to meet your own needs, and
then name and save the table in the database.

Creating a Table 
Using a Template

Create a Table Using a Template

Click the Create tab.

Click the Table Templates button.

Click the table template (Contacts,
Tasks, Issues, Events, or Assets)
you want.

To change a field name, double-
click the field name, type the new
name, and then press Enter. 

Click the Save button on the Quick
Access Toolbar. 

Type a table name. 

Click OK. 

To have Access set the primary
key, click Yes. 

When you’re done, click the Close
button in the Table window. 
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Did You Know?
You can insert a subdatasheet in a
table. In the Datasheet view of a table,
click the Home tab, click the More but-
ton, point to Subdatasheet, and then
click Subdatasheet. Click the Tables
tab, click the table, specify the foreign
key in the Link Child Fields box and the
primary key in the Link Master Fields
box, and then click OK.

You can view a subdatasheet. In the
Datasheet view of a table, click the
plus box next to the record to display
the subdatasheet. Click the minus box
to hide the subdatasheet. 
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You can create new tables from other Access databases by importing
and linking tables. When you import a table, you copy data from a table
in one Access database and place it in a new table in your database.
You can also import data from other programs. After you select the
table you want to import during the import process, you have the option
of saving the import steps for use again in the future. 

Importing Data 
into Tables

Import a Table from a Database

Click the External Data tab.

Click the Import Access Database
button.

Click Browse, locate and select
the database file that contains the
data you want to import, and then
click Open. 

Click the Import tables, queries,
forms, reports, macros, and
modules into the current database
option.

Click OK.

Click the tables you want to
import. To deselect a table, click
the table again.

Click OK.

To save import steps, select the
Save import steps check box,
enter a name and description, and
then click Save Import.

Otherwise, click Cancel.
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Did You Know?
You can select fields in the order you
want them to appear in the table. 
In the Sample Fields list, you can
choose the fields you want to include
in your table in any order. The fields
you choose will appear in the table in
the order you chose them.
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You can create new tables from other Access databases by importing
and linking tables. When you link a table, the data stays in its original
location, but you can display and access that data from within your
database. If data in the original database changes, the changes will
appear in your linked database, too. After you select the table you want
to link during the linking process, you have the option of saving the
import steps for use again in the future. 

Linking to Data 
in Tables

Link to Data from a Database

Click the External Data tab.

Click the Import Access Database
button.

Click Browse, locate and select
the database file that contains the
data you want to import, and then
click Open. 

Click the Link to the data source
by creating a linked table option.

Click OK.

Click the tables you want to
import. To deselect a table, click
the table again.

Click OK.

To save import steps, select the
Save import steps check box,
enter a name and description, and
then click Save Import.

Otherwise, click Cancel.
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A database is made up of groups of fields organized into tables. A field
is a specific category of information, such as a name or a product.
Related fields are grouped in tables. You usually enter data into fields
one entity at a time (one customer at a time, one product at a time, and
so on). Access stores all the data for a single entity in a record. You
can view a table in Datasheet or Design view. Design view allows you
to work with your table’s fields. Datasheet view shows a grid of fields
and records. The fields appear as columns and the records as rows.
The first field in a table is often an AutoNumber field, which Access
uses to assign a unique number to each record. You can’t select or
change this value. You can use Record buttons at the bottom of the
table in Datasheet view to quickly move around and search for data in
a table.

Working with 
Table Records

Enter a New Record and Move
Around in a Table

In the Navigation pane, double-
click the table you want to open. 

Click the New Record button. 

Press Tab to accept the
AutoNumber entry. 

Enter the data. If you make a
typing mistake, press Backspace.

Press Tab to move to the next field
or Shift+Tab to move to the
previous field.

When you reach the end of the
record, click one of the Record
buttons:

◆ First Record button.

◆ Previous Record button.

◆ Specific Record box. Enter a
record number in the box, and
then press Enter.

◆ Next Record button.

◆ Last Record button.

TIMESAVER You can also use
buttons in the Records group on
the Home tab to perform the same
commands.

6

5

4

3

2

1

2 46

AC07S-1.3.1, AC07S-3.1
AC07S-3.2

C03AC07.qxd  12/14/2006  10:36 PM  Page 56



Chapter 3 Planning and Creating a Custom Database 57

Search for Records

In the Navigation pane, double-
click the table you want to open. 

If you want, click in the table field
where you want to start the
search.

Click in the Search box.

Type the text you want to find in
the table.

Press Enter to find the first
instance of the text you want to
find.

Press Enter again to find the next
instance of the text you want to
find.

When you’re done, delete the text
in the Search box.

Delete a Record from a Table

In the Navigation pane, double-
click the table you want to open.

Right-click the row selector with
the record you want to delete.

Click Delete Record, and then
click Yes to confirm.

TIMESAVER Click the row
selector, click the Home tab, and
then click the Delete button.

3

2

1

7

6

5

4

3

2

1

2 3

1 2

3 4

C03AC07.qxd  12/14/2006  10:36 PM  Page 57



58

Most Access objects are displayed in Design view, which allows you to
work with the underlying structure of your tables, queries, forms, and
reports. To create a new table in Design view, you define the fields that
will comprise the table before you enter any data. In Design view for
tables, each row corresponds to a field. You can edit, insert, and delete
fields in your database tables in Design view. You insert a field by
adding a row, while you delete a field by removing a row. You can also
change field order by dragging a row selector to a new position.

Working with a Table
in Design View

Create or Modify a Table in
Design View

Click the Create tab, and then click
the Table Design button, or select
the table you want to modify in the
Navigation pane, and then click
the Design View button.

Click in a Field Name cell, and
then type a modified field name. 

Click in a Data Type cell, click the
Data Type list arrow, and then
click a data type.

Click in a Description cell, and
then type a description. If the
Property Update Options button
appears, select an option, if
necessary.

To insert a field, click the row
selector below where you want
the field, and then click the Insert
Rows button on the Ribbon.

To delete a field, click the row
selector for the field you want to
delete, and then click the Delete
Rows button on the Ribbon.

Click the Save button on the Quick
Access Toolbar, and then if
necessary, enter a table name and
click OK.

When you’re done, click the Close
button in the Table window.
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A primary key is one or more fields in a table that provide a unique
identifier for every row. You use the primary key in other tables to refer
back to the table with the primary key. In Design view, you can use the
Primary Key button to assign or remove the primary key designation for
the selected field or fields. When you create a new table in Datasheet
view, Access automatically creates a primary key and assigns it the
field name “ID” and the data type AutoNumber. When you create a
table in Design view, you can specify more than one field as a primary
key, known as a composite key, so you are responsible for determining
the data type of the primary key. Whatever data type you choose, val-
ues for the primary key must be unique for each table record. 

Chapter 3 Planning and Creating a Custom Database 59

Specifying a Primary
Key in Design View

Specify a Primary Key

In Design view, create a field that
will be that table’s primary key,
and then select an appropriate
data type.

◆ If you choose the AutoNumber
data type, Access assigns a
value to the primary key for a
new record that is one more
than the primary key in the
previous record.

◆ If you choose any other data
type, such as Text, Number, or
Date/Time, during data entry,
you must enter a unique value
in the appropriate format for
the primary key of each new
record.

Click the row selector of that field.

◆ To create more than one
primary key, press and hold
Ctrl, and then click the
additional row selector for
each field.

Click the Primary Key button. 

To remove a primary key, delete
any table relationships associated
with the primary key, select the
row selector for the Primary key,
and then click the Primary Key
button. 
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When you place data into separate tables, you
need some way of merging this data together
for forms and reports. You can do this by
establishing table relationships that indicate
how data in one table relates to data in
another.

Specifying Common Fields
Data from several different tables is related
through the use of common fields. A common
field is a field existing in two or more tables,
allowing you to match records from one table
with records in the other tables. For example,
the Customers table and the Orders table
might both contain a Customer ID field, which
functions as a primary key that identifies a
specific customer. Using Customer ID as a
common field allows you to generate reports
containing information on both the customer
and the orders the customer made. When you
use a primary key as a common field, it is
called a ffoorreeiiggnn key in the second table. 

Building Table Relationships
Once you have a way of relating two tables
with a common field, your next task is to
express the nature of that relationship. There
are three types of relationships: one-to-one,
one-to-many, and many-to-many.

A table containing customer names and a
second table containing customer addresses
exist in a one-to-one relationship if each cus-
tomer is limited to only one address.
Similarly, a one-to-many relationship exists
between the Customers table and the Orders
table because a single customer could place
several orders. In a one-to-many relationship
like this, the “one” table is called the pprriimmaarryy

ttaabbllee, and the “many” table is called the
rreellaatteedd  ttaabbllee. 

Finally, if you allow several customers to
be recorded on a single order (as in the case
of group purchases), a many-to-many rela-
tionship exists between the Customers and
Orders tables.

Maintaining Referential Integrity
Table relationships must obey standards of
rreeffeerreennttiiaall  iinntteeggrriittyy, a set of rules that control
how you can delete or modify data between
related tables. Referential integrity protects
you from erroneously changing data in a pri-
mary table required by a related table. You
can apply referential integrity when:

◆ The common field is the primary 
table’s primary key.

◆ The related fields have the same 
format.

◆ Both tables belong to the same 
database.

Planning Table Relationships

Table Relationships

Choice Description

One-to-one Each record in one table is 
matched to only one record in a 
second table, and visa versa.

One-to-many Each record in one table is 
matched to one or more records 
in a second table, but each 
record in the second table is 
matched to only one record in 
the first table.

Many-to-many Each record in one table is 
matched to multiple records in a 
second table, and visa versa.

AC07S-1.2.1,
AC07S-1.2.2
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Referential integrity places some limitations
on you.

◆ Before adding a record to a related 
table, a matching record must already
exist in the primary table.

◆ The value of the primary key in the 
primary table cannot be changed if 
matching records exist in a related 
table.

◆ A record in the primary table cannot 
be deleted if matching records exist in
a related table.

Access can enforce these rules by cascad-
ing any changes across the related tables. For
example, Access can automatically copy any
changes to the common field across the
related tables. Similarly, if a record is deleted
in the primary table, Access can automatically
delete related records in all other tables.

As you work through these issues of
tables, fields, and table relationships, you will
create a structure for your database that will
be easier to manage and less prone to data-
entry error.

Table relationship

Define table 
relationships
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You can define table relationships in several ways. After you create
tables in your database, you can define table relationships between
them. You can define and manage relationships using buttons on the
Database Tools tab. This gives you control over your table relationships
and also gives you a quick snapshot of all the relationships in your
database. After you define a relationship, you can double-click the con-
nection line to modify or add to the relationship.

Defining Table
Relationships

Define Table Relationships

Click the Database Tools tab.

Click the Relationships button.

If relationships are already
established in your database, they
appear in the Relationships
window. In this window you can
create additional table
relationships. 

If necessary, click the Show Table
button to display the Show Table
dialog box.

Click the Tables tab.

Click the table you want.

Click Add.

The table or query you selected
appears in the Relationships
window. 

Repeat steps 5 and 6 for each
table you want to use in a
relationship.

Click Close.

Drag the common field in the first
table to the common field in the
second table. When you release
the mouse button, a line appears
between the two tables, signifying
that they are related. Also, the Edit
Relationships dialog box opens, in
which you can confirm or modify
the relationship.
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Click the Join Type button if you
want to specify the join type. Click
OK to return to the Edit
Relationships dialog box.

Click Create to create the
relationship.

10

9

Did You Know?
You can view the relationships you
want to see. Click the Design tab
under Relationship Tools, click the
Show Direct Relationships button to
see tables that are directly related to
each other. Click the All Relationships
button to see all the relationships
between all the tables and queries in
your database.

You can print the Relationships 
window. Click the Design tab under
Relationship Tools, click the
Relationships Report button the
Relationships window you want to
print, click the Print button, select the
print settings you want, and then 
click OK.

You can delete a table relationship. 
In the Relationships window, right-
click the line that joins the tables that
you no longer want related to one
another, and then click Delete. In the
message box, click Yes to confirm that
you want to permanently delete this
relationship. You will not be able to
undo this change.

Join Types 

Join Types Description

Include rows only where Choose this option if you want to see
the joined fields from one record in the second table for
both tables are equal every record that appears in the first 

table. The number of records you see in 
the two tables will be the same.

Include ALL records from Choose this option if you want to see
“xxx” (the first table) all the records in the first table (even
and only those records if there is no corresponding record in
from “yyy” (the second the second table) as well as the records
table) where the joined from the second table in which the
fields are equal joined fields are the same in both 

tables. The number of records you see
in the first table might be greater than
the number of records in the second 
table.

Include ALL records from Choose this option if you want to see all
“yyy” (the second table) the records in the second table (even if
and only those records there is no corresponding record in the
from the “xxx” (the first first table) as well as the records from
table) where the joined the first table in which the joined
fields are equal fields are the same in both tables. The 

number of records you see in the 
second table might be greater than the
number of records in the first table.
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After you create a table relationship, you can create and print a report.
In the Relationships window, the Relationship Report button creates a
report with the currently displayed relationship and switches to Print
Preview, where you can print the report. When you close Print Preview,
the report appears in Design view. If you want, you can make changes
to the report. To complete the process, you need to save and name the
report or close it without saving it. Instead of printing the report, you
can also use exporting tools in Print Preview to save the report in
another format, including a PDF or XPS document.

Creating and Printing 
a Table Relationship
Report

Create and Print a Table
Relationship Report

Click the Database Tools tab.

Click the Relationships button.

If relationships are already
established in your database, they
appear in the Relationships
window.

Do any of the following to display
the table relationships you want to
use to create a report: 

◆ Hide tables. Click the table you
want to hide, and then click the
Hide Table button.

◆ Add tables. Click the Tables
tab, click the table you want,
click Add, and then click Close.

Click the Relationship Report
button.

The report appears in Print
Preview.

To print the report, click the Print
button, specify the settings you
want, and then click OK.

Click the Close Print Preview
button. 

The relationship report appears in
Design view.

6

5

4

3

2

1

4 3

5 6Relationship report
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Click the Save button on the Quick
Access Toolbar.

Type a name for the relationship
report.

Click OK.9

8

7

Did You Know?
You can show direct relationships. In
the Relationships window, click the
Direct Relationships button to display
only tables that relate to each other. 

You can clear relationships. In the
Relationships window, click the Clear
Layout button, and then click Yes to
remove the layout of the Relationships
window.  

Specify the print
options you want

7

9

8

See Also
See “Creating a PDF Document” on
page 300  or “Creating an XPS
Document” on page 301 for information
on using and saving a file with differ-
ent formats.

Did You Know?
You can show direct relationships. In
the Relationships window, click the
Direct Relationships button to display
only tables that relate to each other. 
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Referential integrity in table relationships keeps users from accidentally
deleting or changing related data. If a primary table contains a list of
employees and related tables contain additional information about
those employees, and an employee quits, his record is removed from
the primary table. His records should also be removed in all related
tables. Access allows you to change or delete related data, but only if
these changes are cascaded through the series of related tables. You
can do this by selecting the Cascade Update Related Fields and
Cascade Delete Related Records check boxes in the Edit Relationships
dialog box.

Ensuring Referential
Integrity

Ensure Referential Integrity

Click the Database Tools tab.

Click the Relationships button.

Click the join line for the
relationship you want to work with.

Click the Edit Relationships button.

Select the Enforce Referential
Integrity check box to ensure that
referential integrity always exists
between related tables in the
database.

If you want changes to the primary
field of the primary table
automatically copied to the related
field of the related table, select the
Cascade Update Related Fields
check box.

If you want Access to delete
records in the related tables
whenever records in the primary
table are deleted, select the
Cascade Delete Related Records
check box.

Click OK.8

7
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As you develop a database, you create a relationship between objects
to share data and provide the information in forms and reports. When
you make changes to one object, it might affect another object. For
example, if you no longer need a field in a table, instead of deleting it
right away and possibly creating problems, you can check object
dependencies to make sure that the field you want to delete is not used
in another table. Checking for object dependencies helps you save time
and avoid mistakes. Access generates dependency information by
searching name maps maintained by the Name AutoCorrect feature. If
Track Name AutoCorrect Info is turned off on the Current Database
pane in the Options dialog box, you cannot view dependency 
information.
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Identifying Object
Dependencies

View Dependency Information

In the Navigation pane, click the
database object in which you want
to view dependencies. 

Click the Database Tools tab.

Click the Object Dependencies
button.

Click the Objects that depend on
me or Objects that I depend on
option.

The Object Dependencies task
pane shows the list of objects that
use the selected object.

To view dependency information
for an object listed in the pane,
click the Expand icon (+) next 
to it.

When you’re done, click the Close
button on the task pane.

6

5

4

3

2

1

Did You Know?
You can view a list of database
objects. Click the Office button, click
point to Manage, click Database
Properties, and then click the Contents
tab. When you’re done, click OK.

Dependency Information

Object Dependent Description

Table Table or query A relationship is defined between the objects

Table Form Fields in the selected table look up values

Query Table or query Query is bound to the table or query

Form Table or query Form is bound to the table or query

Form Form Form includes the other form as a subform

Report Table or query Report is bound to the table or query

Report Form Report includes the form as a subform

Report Report Report include the other report as a subreport 

1 2 3 4

6

5
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As you view dependencies for an object in the Object Dependencies
task pane and determine you can make changes without effecting
other objects, you can open an object in Design view directly from the
Object Dependencies task pane and modify it. If you need to look at
other objects, you can open more than one from the Object
Dependencies task pane. If you are having problems viewing depend-
ency information, you need to turn on the Track Name AutoCorrect Info
option on the Current Database pane in Access Options.

68

Modifying Object
Dependencies

Modify Dependency Information

In the Navigation pane, click the
database object in which you want
to view and modify dependencies. 

Click the Database Tools tab.

Click the Object Dependencies
button.

Click the Objects that depend on
me or Objects that I depend on
option.

The Object Dependencies task
pane shows the list of objects that
use the selected object.

Click the Expand icon (+) next 
to an object to view dependency
information.

Click the object you want to open
in Design view.

Modify the object in Design view,
and then click the Close button in
the Design view window.

When you’re done, click the Close
button on the task pane.
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